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3Warranty and Copyright

Limited Warranty on CADlink Products 
CADlink warrants that the disk medium upon which the product is recorded, and any hardware accompanying said 
disk(s), shall be free from defects in materials and workmanship -- under normal use and service for a period of  ninety 
(90) days from the date of  delivery, as evidenced by a copy of  the receipt.
CADlink’s entire liability and exclusive remedy as to the disk(s) or hardware shall be at CADlink’s option -- either (a) 
return of  the purchase price, or (b) replacement of  the disk(s) or hardware that do not meet CADlink’s Limited Warranty. 
These must be returned to CADlink postage pre-paid with a copy of  the receipt.
If  failure of  the disk(s) or hardware has resulted from accident, abuse or misapplication, CADlink shall have no 
responsibility to replace the disk(s) or hardware, the replacement will be warranted for the remainder of  the original 
warranty period or thirty (30) days, whichever is longer. Other then the above limited warranty, CADlink makes no other 
warranties whatsoever, either legal or conventional, express or implied, with respect to the licensed software and hardware. 
You are advised to test the licensed software thoroughly before relying on it. You assume the entire risk of  using the 
licensed software. Because of  the diversity of  conditions and hardware under which the licensed software may be used, 
no warranty of  merchantability or fitness for a particular purpose is given. Some regions do not allow the exclusion of  
implied warranties, so the above exclusion may not apply.

Copyright Notice
PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, 
Inc. trademarks are the property of  Pantone, Inc., 2010.
Pantone, Inc. is the copyright owner of  color data and/or software which are licensed to CADlink Technology Corp. to 
distribute for use only in combination with SignLab. PANTONE Color Data and/or Software shall not be copied onto 
another disk or into memory unless as part of  the execution of  SignLab and/or Visual Production Manager.
No part of  this publication may be reproduced mechanically or electronically or in any form without the prior written 
permission of  CADlink. The software described in this manual is furnished under license and may only be used or copied 
in accordance with the terms of  such license. The information in this manual is for informational use only, is subject to 
change without notice and should not be construed as a commitment by CADlink. CADlink assumes no responsibility or 
liability for any errors or inaccuracies that may appear in this document. SignLab®, SignLab Vinyl®, SignLab Print and 
Cut®, SignLab Vinyl Pro®, Visual Production Manager®, Visual Print Manager®, and Digital Factory® are registered 
trademarks of  CADlink Technology Corporation.

Written and designed at CADlink Technology Corporation
2150 Thurston Drive, Ottawa, ON, Canada, K1G 5T9
Phone (613) 247-0850
Fax (613) 247-1488
Manual & Package Design by CADlink Marketing and Customer Support.
Printed in Canada. Product of  Canada.
© December 2010, CADlink Technology Corporation
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Contact Information
After using this guide to configure your shop equipment, you should have a good impression of  how the tools can be used 
to improve your shop efficiency. However, if  you have questions about the SignLab Trial, then please contact either your 
assigned dealer, or CADlink directly.

Internet

www.cadlink.com
www.signlab.com

E-mail

sales@cadlink.com

United States

500 Main Street
Clinton, MA 01510
Tel: 1-800-545-9581
Fax: (613) 247-1488

Canada

2150 Thurston Drive
Ottawa, ON K1G 5T9
Tel: (613) 247-0850
Fax: (613) 247-1488

Europe

Intech House, Wilbury Way
Hitchin, Herts, U.K. SG4 0TW
Tel: ++44(0) 1462-420222
Fax: ++44(0) 1462-420111

Germany

Georg Christoph Neller Str. 3
D-54296 Trier
Tel.: +49 (651) 96644840
Fax.: +49 (651) 96644841
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Introduction
This setup guide has been created for users that are evaluating the SignLab 9 Trial. These setup configurations have 
been excerpted from the SignLab 9 User Guide, which will be provided as part of  a typical SignLab 9 package. At this 
point, it is expected that you have completed installation of  the SignLab 9 Trial, and you are using this setup guide to 
configure your shop equipment and confirm that you can output jobs as expected.

SignLab
SignLab is Computer Aided Design (CAD) software for signmakers, which provides leading edge technologies as an all-in-
one package for efficient sign shop operation. Development for SignLab is an ongoing process, where new technologies 
and tools are incorporated into SignLab to support modern sign shop needs. Despite the pressure to add new features, 
radical changes to the user interfaces and workflows are avoided, so that signmakers are not inconvenienced when 
upgrading to the latest SignLab.
SignLab tools are simple and versatile for designing with text, line art, and images (i.e., bitmaps). SignLab also provides 
significant support for other design applications, so that unfinished or archived designs can be brought into SignLab for 
pre-production work.

Visual Production Manager
Included with SignLab Print and Cut is the Visual Production Manager (VPM), which is a production management tool 
that serves as a repository for all of  your volume production printing and/or cutting activities. Sorting and accumulating 
jobs is accomplished by creating one-or-more queues for each of  your machines, thereby providing a simple means for 
designers to output their designs.
From a designer perspective, a queue in Visual Production Manager appears as a print destination (i.e., in the application 
Print dialog), and designers are otherwise insulated from the technical aspects of  production. However, for the operator 
that oversees production, they are presented with a clean interface that allows them to preview jobs at a glance, and 
intuitive controls that can be set behind-the-scenes.

Send to VPM Plug-ins
As a means of  avoiding the Print dialog configuration steps within your PhotoShop, Illustrator and/or CorelDraw 
packages, special plug-ins are provided that allow a design to be sent directly to SignLab or VPM. In this manner, you have 
increased freedom to choose the workflow that best suits your production requirements.



6Sending Jobs from SignLab

Sending Jobs from SignLab
Once you have completed the SignLab installation, choose from the following workflows to confirm that print and/or cut jobs are being 
received and processed as expected. By completing the workflow that best corresponds to your shop configuration, you will develop a greater 
understand about the SignLab interface.

□□ Deciding when to Cut, Print, Print&Cut, etc. - When in doubt, review these pointers to help you choose the workflow that best suits 
your needs.

□□ Choosing Registration Marks and Alignment Systems - This section provides additional comments about aligning cut operations to 
print jobs.

□□ Print and/or Cut from SignLab - Use this workflow for SignLab Print & Cut packages, where jobs will be processed by Visual 
Production Manager (VPM) and output to a printer and/or cutter.

□□ Contour Cut-only from SignLab - Use this workflow for SignLab Vinyl, Vinyl Pro, and CutPro packages, where jobs are output from 
SignLab to the cutter.

□□ Garment Printing from SignLab - Use this workflow with the Garment Decorating Module to print to both white and black garment 
material. See also the Sending Jobs from PhotoShop/Illustrator/CorelDraw sections.

□□ Cutting Rhinestone Patterns from SignLab - Use this workflow with the Garment Decorating Module to place rhinestones and then 
output the cut pattern to the cutter.

□□ Rotary Engraving from SignLab - Use this workflow with the Engraving Module to configure machine settings within SignLab and 
output a tool path to the engraver.

□□ Laser Engraving from SignLab - Use this workflow to configure SignLab for File menu >> Print output to your laser engraver.
□□ Routing from SignLab - Use this workflow with the Sign Routing Module to configure SignLab with material definitions, cutting tools, 

and cut templates for output to a router.

□□ Print and/or Cut to Roland VersaWorks - Use this workflow with the SignLab for VersaWorks™ Edition to configure SignLab for 
sending output to Roland VersaWorks.

□□ Print and/or Cut to Mimaki Rasterlink - Use this workflow with the SignLab for Mimaki™ Edition to configure SignLab for sending 
output to Mimaki RasterLink.

For workflows that involve sending jobs from third-party design applications to VPM, see Sending Jobs to Visual 
Production Manager (VPM)
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Deciding when to Cut, Print, Print&Cut, etc.
Due to the variety of  supported workflows in SignLab, the following differences should be noted about how jobs are output from SignLab:

Printing versus Print&Cut
□□ Both “print only” and “print and cut” jobs can be processed through the Print and Cut command.
□□ A “print and cut” job is like a regular print job, except that contour cut paths are applied after the print portion of  the job. For example, 

stickers are commonly created through a “print and cut” process.
□□ Though the File menu >> Print command is available in SignLab, it is typically used for printing simple drafts or customer proofs to a 

desktop printer, whereas large format printing should be performed through the Print and Cut command.

Contour Cutting versus Print&Cut
□□ When using the Print and Cut command, all workspace shapes are considered to be print-only objects, except contour cut paths that 

represent cut-only objects.
□□ Cut paths are created using the Cut menu tools, such as Contour Cut, Contour Cut On/Off, or Die Cut.
□□ The Print and Cut command is not available with SignLab Vinyl, Vinyl Pro, or CutPro packages. Instead, cut jobs are sent via Cut menu 

>> Plot.
□□ When using Cut menu >> Plot, all workspace shapes are treated as cut-only objects.

Contour Cutting versus Routing or Engraving
□□ For both the SignLab Sign Routing Module, and the SignLab Engraving Module, the Tool Path Tools are first used to create tool paths, and 

then jobs are sent via Cut menu >> Plot.
□□ If  contour cut paths are output to a router or engraver, the cut paths will be of  zero depth (i.e., the cut path will score the material).
□□ Since laser engravers use a Windows printer driver, such jobs are sent from SignLab using File menu >> Print.

Visual Production Manager, VersaWorks, and RasterLink
□□ Print and cut jobs sent from SignLab will be received and processed through the Visual Print Manager, unless either the SignLab for 

VersaWorks or SignLab for Mimaki Editions have been purchased.
□□ For the SignLab for VersaWorks Edition, the Print to Roland VersaWorks command will process jobs through your VersaWorks RIP 

software (either queue A or B).
□□ For the SignLab for Mimaki Edition, the Print to RasterLink command will cause jobs to be processed through your Rasterlink RIP 

software.
□□ Regardless of  the choice of  RIP, the software should be launched prior to sending the job from SignLab, rather than rely upon Windows 

to launch the RIP software automatically.
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Choosing Registration Marks and Alignment Systems
SignLab provides support for an extensive variety of  printers and cutters, both in terms of  manufacturers and machine models. However, the 
technology used for printer-cutter alignment varies, such as the following:

□□ Hybrid printers that automatically align cut operations after completing the print job.
□□ Printers that automatically print registration marks that will be used for cut alignment.
□□ For print-laminate-cut jobs, where the printed job will be laminated and loaded back into the hybrid printer for cutting, the printer will 

typically print the registration marks that it needs for cut alignment. 
□□ Cutters that have optical eye systems (i.e., a laser) that can automatically align to specific types of  registration marks.
□□ Cutters that do not have optical eye systems, which require that the operator visually position the cutting tool according to the 

registration marks. In such cases, it is recommended that Three point automatic registration marks be created (if  available).
□□ For cut vinyl applications, cutting registration marks that are used to visually align multiple layers of  color vinyl.

When configuring your printer and/or cutter, it is important to consider both the job application, and the choices of  printer/cutter alignment 
that are detailed within the Operator Manuals of  the given machines.

Depending upon the type of  work being performed, it may be necessary to manually add registration marks within SignLab, or to 
automatically add registration marks within Visual Production Manager.

Registration Marks in SignLab
□□ In SignLab, choose Shapes Tools >> Registration Mark to manually place individual registration marks.
□□ Likewise, choose Shapes Tools >> Multi-Registration Mark to place sets of  registration marks.
□□ The Multi-Registration Mark tool is also available in Cut Preview mode (i.e., for cut-only jobs).
□□ These tools are typically used for cut vinyl applications, though they can be equally applicable for print&cut applications, provided that 

the marks are placed according to the Operator Manual guidelines.

Registration Marks in Visual Production Manager
□□ Visual Production Manager can automatically add registration marks when jobs are received.
□□ Depending upon how the queue is configured, marks can be added for individual jobs, or for sets of  jobs that have been nested upon 

the media.
□□ Automatic registration marks can be set as follows:

1.	 Choose Queue menu >> Properties.
2.	 Click the Registration Marks tab.
3.	 From the Select registration system drop-list, choose the type of  registration marks (Fig. 1).

Fig. 1 - If the registration system is set as “disabled,” then Visual 
Production Manager will not automatically create registration 
marks.
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Print&Cut

Print&Cut

Print&Cut

Print and/or Cut from SignLab
Use this workflow to print and/or cut jobs from SignLab to a local or remote-connected printer. This workflow is typical of  working with a 
SignLab Print and Cut package.

In this workflow, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a print&cut 
job). If  you wish to complete a print-only job, then skip the steps in gray.

In Visual Production Manager
1.	 From the toolbar, click the Start Queue button.
2.	 Choose Queue menu >> Manage Queues.
3.	 Verify that the Port settings are correct for the printer and/or cutter that will be used.
4.	 Click the Close button.

5.	 For print&cut jobs, it may be necessary to set Visual Production Manager to automatically create registration marks. Please review the 
Choosing Registration Marks and Alignment Systems section.

In SignLab
6.	 Prepare the print design on the SignLab workspace.

7.	 Select the design and use Cut menu >> Contour Cut to create a cut path around the design.

8.	 Choose File menu >> Print and Cut to open the Print and Cut dialog.
9.	 From the Printing queues drop-list, choose the queue that will receive the job in Visual Production Manager.

Note: If  VPM has been installed on another computer, then click the Add Remote Printing Queue button, and select the VPM install 
directory on the remote computer.

10.	 Click OK to proceed, and the job will be received in Visual Production Manager.

In Visual Production Manager

11.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
12.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

13.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Remote Cutter

Contour Cut-only from SignLab
Use this workflow to cut jobs directly from SignLab to a local or remotely connected cutter. This workflow is typical of  working with either 
the SignLab Vinyl, Vinyl Pro, or CutPro packages.

1.	 From the Start menu, launch SignLab.
2.	 Prepare the cut design on the SignLab workspace.

Vector shapes will be treated as cut objects, whereas bitmap images must be vectorized into vector shapes.

3.	 Choose Cut menu >> Plotting Defaults to open the Plot dialog.
4.	 Verify that the Selected Driver indicates the cutter that will receive output.

If  the cutter is not available, then use File menu >> Install Cutting Devices.

5.	 To commit your changes to the Plot dialog, click the Apply button.
6.	 Click the Setup button to open the Plotter Setup dialog.
7.	 Click the Port tab.
8.	 If  the cutter is connected directly to the computer that SignLab is installed, then click the Direct to Port option. Skip to step (12).

9.	 For a cutter that is on a remote computer, click the Use Visual Production Manager option.
10.	 Click the New Remote Visual Production Manager button. Browse to the VPM directory on the remote computer. The “queue 

name” associated with the Visual Production Manager on the remote computer will be added to the drop-list.
11.	 From the drop-list, select the “queue name” that has been configured on the remote computer.

12.	 Verify that the Port Location indicates the port to which the cutter is connected.
13.	 Click OK to close the Plotter Setup dialog.
14.	 Click OK to close the Plot dialog.
15.	 Confirm that the cutter is ON, connected to the expected port, and is ready to accept data.
16.	 Choose Cut menu >> Plot to preview the job.

Alternatively, click the Cut button on the Tools toolbar.

17.	 In the SmartBar, confirm that the Device is the cutter that you had selected (Fig. 2).
18.	 At the far-right of  the Cut Toolbox, click the Cut button.
19.	 The cut data is now sent to your cutter, and the cutter should proceed to cut the job.

Fig. 2 - Cut Preview mode is used 
to preview your design as it will be 
cut on the material. Click the Cut 
button to send the cut data to the 
cutter.
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Garment Printing from SignLab
With the SignLab Garment Decorating Module, when you created your first queue, you were asked to set “White T-Shirt” as the queue name, 
which would differentiate it from the “Black T-Shirt” queue that we will create shortly.

Note: For alternative garment printing tools, see the Sending Jobs from PhotoShop/Illustrator/CorelDraw sections.

Print to White Garment Material
Before we proceed with printing to a black garment, use the following procedure to confirm that Visual Production Manager (VPM) is 
communicating to the printer as expected.

1.	 Prepare or import a design on the SignLab workspace.
2.	 Choose File menu >> Print and Cut and choose the “White T-Shirt” queue.
3.	 The job will be received in VPM.
4.	 Turn on the printer and wait until it indicates readiness for receiving print jobs.
5.	 Load a white T-shirt onto the printer platen.
6.	 A preview of  this job will appear in Visual Print Manager. To adjust its positioning or size, click this job in the Visual Print Manager to 

access context-sensitive controls.
7.	 In the Active List, right-click the job and choose Print.

Create a Second Queue for Black Garment Material
Now that we have confirmed that VPM is communicating to the printer, we shall now create a “Black T-shirt” queue, and we will prepare a 
design with a white ink underbase. Here are some pointers before we proceed:

□□ For black and color garments, an underbase layer (i.e., a printed layer of  white ink) is critical for avoiding hue shifts in your printed 
design.

□□ Alternatively, to create an underbase layer in your design application, create an alpha channel (i.e., transparency layer), and define your 
underbase information on that layer. VPM can then convert the alpha channel into an underbase layer.

□□ As described in Sending Jobs to Visual Production Manager (VPM), special Send to VPM plug-ins are available for your PhotoShop, 
Illustrator and CorelDraw design applications, such that your designs can be sent directly to VPM, and the alpha channel will be 
converted into an underbase layer.

□□ However, DO NOT USE the File menu >> Print command from your design application because the alpha channel will be discarded 
(i.e., no underbase layer will be created).

□□ For applications other than PhotoShop, Illustrator and CorelDraw, it may be necessary to save the design file in a format that can store 
the alpha layer information, and then the file can be imported into VPM.

Create the Black T-Shirt Queue In VPM
1.	 From the Queue menu, choose Manage Queues to open the Queue Manager.
2.	 Click the Add Queue button to launch the Create Queue Wizard.
3.	 Choose the previously installed printer from the Installed Devices drop-list.
4.	 On the Printer Defaults page, choose the output port and print mode (media profile) for your printer.

□□ For the output port, if  you are using the same printer as you had chosen for your previous “White T-Shirts“ queue, then set the 
same port here.

□□ To the right of  the Print Mode drop-list, clicking the ellipsis (...) button will open the Print Mode Selection dialog. Typically, if  
the same printer is being used, then the same print mode that you chose for your “White T-Shirts“ queue will be fine.

5.	 On the Name Your Production Queue page, you are asked to provide a meaningful name for referring to this queue.
□□ Set the name as “Black T-Shirts”.

6.	 For the subsequent three pages of  the wizard, use the same settings that you set for your White T-Shirts queue.
□□ Media Setup page - Previously, you had likely set Fixed Sheet or Templates.
□□ Layout Mode page - Use Auto Page for garment printing.
□□ Output Options page - For garments, choose either Hold (i.e., do nothing), or RIP Now, Print later (i.e., spend time creating a 

spool file, but don’t send to the printer yet).

7.	 Once these wizard pages have been completed, close the Queue Manager dialog.
8.	 Your Black T-Shirts tab will now be available, which can be clicked to view the jobs that are pending in that queue.
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Print to Black Garment Material
9.	 Prepare or import a design on the SignLab workspace.
10.	 Use Image menu >> CADlink >> KnockMeBlackOut to prepare the design for black garment printing. For color garments, use 

KnockMeColorOut.
11.	 Choose File menu >> Print with Underbase, and choose the “Black T-Shirt” queue.

This command is similar to File menu >> Print and Cut, except that the entire design will be converted into PNG data (i.e., bitmap) 
that retains transparency info.

12.	 When the job is received in VPM , the Image Import dialog will prompt for the underbase settings.
Note: The underbase settings appear only when applicable for the given printer.

13.	 Click OK to set your underbase settings, and the job will appear in the Active List.
14.	 Turn on the printer and wait until it indicates readiness for receiving print jobs.
15.	 Load a black T-shirt onto the printer platen.
16.	 Right-click the job and choose Print.
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Cutting Rhinestone Patterns from SignLab
With the SignLab Garment Decorating Module, tools are provided for easily distributing rhinestones along the contours and within the fill areas 
of  both vector objects and images. The design can then be output to a cutter that will cut the holes into a sheet of  material, which can then 
be used for positioning rhinestones upon garment material. The following steps provide an example of  creating such a design and outputting 
it to a cutter.

1.	 Suppose that we have imported clipart of  an apple onto the SignLab workspace.
2.	 Select the vector artwork and choose Transform menu >> Rhinestone >> Rhinestone Fill.
3.	 The Rhinestone Fill options will appear in the SmartBar (Fig. 3).

4.	 Suppose that we only want to apply rhinestones to the artwork contour.
5.	 Clear the Fill checkbox.
6.	 Tick the Outline checkbox.
7.	 Click the Select Elements button.
8.	 The Element Selector dialog will open (Fig. 4).

9.	 From the Available Elements list, click the desired rhinestone size.
10.	 From the color picker, choose the rhinestone color.
11.	 Click the Add button, and your choice will appear in the Element List.

Optionally, add two-or-more rhinestones of  varying size and/or color, and the resulting rhinestones will cycle through your choices that 
are in the Element List.

12.	 Click the OK button, and the resulting rhinestones will be shown on the workspace (Fig. 6).
13.	 Use the SmartBar controls to modify your choices, or click Close to finish editing.

Fig. 3 - The Rhinestone Fill tool can be used to place rhinestones for both an object 
outline or fill.

Fig. 4 - In the Element Selector dialog, the rhinestones added to the left 
will be repeated in the design. For example, if only one red and one yellow 
are chosen, then the result will be red+yellow+red+yellow+ etc.

Fig. 5 - The spacing between rhinestones can be toggled, 
depending upon how you prefer to space them.
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Notes:
□□ In the SmartBar, the Element Spacing value is automatically calculated according to your choice of  rhinestone(s), and the choice of  

artwork. After step (12), the Element Spacing value can be increased manually, which will reduce the number of  rhinestones being 
applied (i.e., the Outline Count).

□□ The Center to Center Spacing button (Fig. 5) will toggle how the Element Spacing value is measured between rhinestones.

Sending the Rhinestone Cut Data
The procedure for cutting rhinestones is virtually the same as described in Contour Cut-only from SignLab, except that the Cut menu >> Only 
Output Rhinestones option must be enabled.

1.	 Choose Cut menu >> Plotting Defaults to open the Plot dialog.
2.	 Verify that the Selected Driver indicates the cutter that will receive output.

If  the cutter is not available, then use File menu >> Install Cutting Devices.

3.	 To commit your changes to the Plot dialog, click the Apply button.
4.	 Click the Setup button to open the Plotter Setup dialog.
5.	 Click the Port tab.
6.	 If  the cutter is connected directly to the computer that SignLab is installed, then click the Direct to Port option.
7.	 Verify that the Port Location indicates the port to which the cutter is connected.
8.	 Click OK to close the Plotter Setup dialog.
9.	 Click OK to close the Plot dialog.
10.	 Confirm that the cutter is ON, connected to the expected port, and is ready to accept data.
11.	 Confirm that the Cut menu >> Only Output Rhinestones option (Fig. 7) has a checkmark.
12.	 Choose Cut menu >> Plot to preview the job.

Alternatively, click the Cut button on the Tools toolbar.

13.	 In the SmartBar, confirm that the Device is the cutter that you had selected.
14.	 At the far-right of  the Cut Toolbox, click the Cut button.
15.	 The cut data is now sent to your cutter, and the cutter should proceed to cut the job.

Fig. 6 - The result of applying a rhinestone fill to an object contour.

Fig. 7 - Cutting the holes for rhinestones is similar to regular 
contour cut operations, except that the Only Output 
Rhinestones option must be enabled.
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Rotary Engraving from SignLab
With the SignLab Engraving Module, the following procedure describes how to configure SignLab for a rotary engraving job. We will begin by 
adjusting the machine settings within SignLab, creating a design that has a tool path for engraving, previewing how that design will appear 
before output, and then sending the job to be cut.

Note: For laser engravers, please refer to the subsequent procedure, Preparing a Laser Engraving Job.

Machine Setup
When SignLab is installed for the first time, or when drivers for a new machine have been installed, the Plot dialog should 
be used to configure SignLab for output to the machine.
1.	 From the Windows Start menu, launch SignLab.
2.	 Choose Layout menu >> Blank Size, and set the Width and Height according to the cutting area of  your machine.
3.	 Choose Cut menu >> Plotting Defaults to open the Plot dialog (Fig. 8)

4.	 Verify that the Selected Driver and Tool settings are correct.
Where shapes will be cut with more than one pass (i.e., cutting to progressive depths), the Tool setting should be “Multiple Pass” or 
“Router” (depending on the machine model).

5.	 Near the bottom-center of  the dialog, ensure that Sign blank is selected.
6.	 The Engrave checkbox will probably be enabled by default. If  so, then clear the checkbox. If  this checkbox is already cleared, then 

proceed to the next step.
7.	 With the Engrave checkbox clear, click the option to tick it. The Tool Path Options dialog will open (Fig. 9).
8.	 Click the Cut Tool Paths option. Enabling this option indicates that the tool paths will be previewed in the Cut Preview state.
9.	 Clear the “Also Cut Contour Paths” option.

If  this option were checked, then all objects (aside from tool paths) will be viewed as contour cutting paths in the Cut Preview state. By 
disabling this option, only tool paths will be previewed in the Engrave Preview state.

10.	 Click OK to return to the Plot dialog.
11.	 Click Apply to confirm your changes.
12.	 Click the Setup button to open the Plotter Setup dialog.
13.	 On the Plotter tab, confirm that the Machine Limits are correct (Fig. 10).
14.	 Set the Origin and End Point according to where you want the machine to start and finish each job.
15.	 Click the Port tab, set the Method = Direct to port (Fig. 11).
16.	 Set the Port Location for the machine.

Fig. 8 - Use the Plot dialog to set default parameters for your 
machine.

Fig. 9 - The Tool Path Options dialog is 
used to enable the creation of tool paths, or 
to automatically apply a default tool path 
to objects.
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In the vast majority of  cases with CNC routers, the port will be “FILE:”, and the router will have a system for downloading the output 
file that is generated by SignLab. For more information, please refer to the Operator Manual that was provided with the router.

17.	 Click OK to close the Plotter Setup dialog.
18.	 Click Close to close the Plot dialog.

Creating a Tool Path
At this point, SignLab has been configured to send output to your machine. Now we want to create a design and assign a tool path that can 
be output for cutting.

1.	 On the SignLab workspace, create a rectangle shape, and make note of  its size and position.
2.	 With the rectangle shape selected, right-click the Online button from the Tool Path Tools flyout. The Online dialog will open (Fig. 12).

Right-click will force the given tool settings dialog to open, whereas left-click will automatically apply the previously set tool settings.

Fig. 10 - On the Plotter tab, confirm the Machine Limits, the Origin, 
and the End Point.

Fig. 11 - On the Port tab, specify the Port Location for 
which the machine is connected. For CNC routers, there is 
often a requirement to save the cut data to a file.

Fig. 12 - Select the shape and right-click Online from the Tool Path Tools flyout to force 
the Online dialog to open. Left-clicking will automatically apply the previous tool settings.
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3.	 Confirm that the Tool and Depth are correct for the desired operation. The Color will be used for displaying the tool path on the 
workspace.

4.	 Click OK to apply the tool path.
5.	 The resulting tool path will appear like a stroke on the rectangle.

If  the tool path is not visible, then confirm that View menu >> Show Tool Paths is enabled.

Previewing and Cutting the Tool Path
1.	 Now that the tool path has been created, choose Cut menu >> Plot to activate Cut Preview mode.

Alternatively, click the Cut Tool to activate Cut Preview.

2.	 The tool path will be previewed as it will be cut upon the material, and a green bounding rectangle used to represent the machine limits 
(Fig. 13).

3.	 In the SmartBar, verify that both the Tool and Device are the same as were selected previously within the Plot dialog.
4.	 At this point, the cut data is ready to be sent from SignLab. Please confirm that the machine is online and loaded with the appropriate 

material.
5.	 On the Cut Toolbox, click the Cut button to begin sending cut data.

Note: If  the Port Location of  the Plotter Setup dialog had been set to “FILE:”, then SignLab will prompt for a filename and file location 
before saving the cut data.

Fig. 13 - In Cut Preview mode, click the Cut button to begin output.
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Laser Engraving from SignLab
Whereas cutting to a rotary engraver uses the Cut menu >> Plot command for sending a job, laser engravers use the File menu >> Print 
command because the printer driver provided with the laser engraver is used to interpret the image data for laser engraving. In this manner, 
laser engravers can interpret object fills and strokes as cut data. 

1. 	 From the Windows Start menu, launch SignLab.
2.	 Choose Layout menu >> Blank Size, and set the Width and Height according to the cutting area of  your machine.

Set a Default Color Palette
1.	 From the Options menu, choose Palette >> Load >> Set Default.

This command is also available through the Shop Palette context menu.

2.	 From the SignLab install directory, browse to the Palettes >> Engrave directory.
3.	 In the Engrave directory are an assortment of  color palettes per different manufacture of  laser engraver. Each palette contains colors 

used by the given manufacturer to indicate speed and power.
4.	 Choose the color palette that corresponds to your laser engraver, and then click the Save button.
5.	 Start a new workspace using File menu >> New.
6.	 Along the bottom of  the workspace, note that the Shop Palette has loaded the manufacturer palette that you had chosen.

Setting Fill and Stroke Colors
With laser engravers, object fill colors produce an engrave fill, and line style colors produce a cutting line.

1.	 Confirm that there is a checkmark beside the View menu >> Show Fill.
2.	 Confirm that there is a checkmark beside the View menu >> Show Tool Paths.
3.	 Create a circle shape and assign a black fill. This circle will be output as an engraving fill.
4.	 Draw a square shape around the circle and assign an Invisible fill to the square (Fig. 14).

5.	 With the square selected, choose Stroke and Fill Tools >> Line Style.
6.	 In the SmartBar, choose a Hairline style.
7.	 Set a red stroke color.

Printing to the Laser Engraver
As mentioned previously, laser engraving output is driven through a printer driver, so output from SignLab in done using the File menu >> 
Print command.

1.	 Choose File menu >> Print to open the Print dialog.
2.	 From the Printer tab, select your laser engraver.

Note: If  your laser engraver is not listed, then refer to the installation instructions provided with your laser engraver.

Fig. 14 - Set an invisible fill by left-clicking Invisible on the Shop 
Palette.
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3.	 Tick the Preview checkbox.
4.	 Click the Preferences tab.
5.	 Tick the Print As Shown On Screen checkbox.
6.	 Click the Sign Blank Area option.
7.	 On the Printer tab, click the Setup button.
8.	 The Properties dialog for your laser engraver will open.
9.	 The controls on the Properties dialog will vary according to your model of  laser engraver. For specific instructions concerning these 

controls, please refer to the documentation provided with your laser engraver.
10.	 The following aspects of  the Properties dialog (e.g., Fig. 15) should be confirmed:

□□ For the colors defined within the driver, adjust the power and speed settings as required.
□□ For each color, set the pen mode to output both raster and vector data.
□□ Confirm that the engraving area is correct.
□□ Set the cutting mode to Black and White.

13. Click OK to accept the Print dialog settings and enter the Print Preview page.

Sending the Laser Engraving Job
1. The file is ready to be sent from SignLab.
2. Confirm that the machine is online and loaded with the appropriate material.
3. In Print Preview, click Print to begin engraving. (Fig. 16)

Fig. 15 - The Properties dialog will vary according to the model of 
laser engraver. To learn more about the available controls, check the 
help instructions that were included with laser engraver.

Fig. 16 - In Print Preview, click the Print button to 
send output to the laser engraver.
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Routing from SignLab
For the SignLab Sign Routing Module, the following sections show the steps that are required to prepare and output cut data to a router.

A) Launch SignLab
1.	 From the Windows Start menu, launch SignLab.

B) Machine Setup
The machine settings must be configured before sending any cut jobs to the machine. 

1.	 Choose Cut menu >> Plotting Defaults to open the Plot dialog (Fig. 17).
2.	 Verify that the Selected Driver and Tool settings are correct. Where shapes will be cut with more than one pass (i.e. cutting to progressive 

depths), the Tool setting should be “Multiple Pass” or “Router” (depending on the machine model).
3.	 Near the bottom-center of  the dialog, ensure that Sign blank is selected.
4.	 The Engrave checkbox will probably be enabled by default. If  so, then clear the checkbox. If  this checkbox is already cleared, then 

proceed to the next step.
5.	 With the Engrave checkbox clear, click the option to tick it. The Tool Path Options dialog will open (Fig. 18)

6.	 Click the Cut Tool Paths option. Enabling this option indicates that the tool paths will be previewed in the Cut Preview state.
7.	 Clear the “Also Cut Contour Paths” option.

If  this option were checked, then all objects (aside from tool paths) will be viewed as contour cutting paths in the Cut Preview state. By 
disabling this option, only tool paths will be previewed in the Engrave Preview state.

8.	 Click OK to return to the Plot dialog.
9.	 Click Apply to confirm your changes.
10.	 Click the Setup button to open the Plotter Setup dialog.
11.	 On the Plotter tab, confirm that the Machine Limits are correct (Fig. 19).
12.	 Set the Origin and End Point according to where you want the machine to start and finish each job.
13.	 Click the Port tab, set the Method = Direct to port (Fig. 20).
14.	 Set the Port Location for the machine.

In the vast majority of  cases with CNC routers, the port will be “FILE:”, and the router will have a system for downloading the output 
file that is generated by SignLab. For more information, please refer to the Operator Manual that was provided with the router.

15.	 Click OK to close the Plotter Setup dialog.
16.	 Click Close to close the Plot dialog.

Fig. 17 - Use the Plot dialog to set default parameters for your 
machine.

Fig. 18 - The Tool Path Options dialog is 
used to enable the creation of tool paths, or 
to automatically apply a default tool path 
to objects.
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C) Define a Material Type
From the Cut menu, choose Material Library and confirm that your material is listed. The material will be used later to categorize the cut 
templates that are used to create tool paths. If  you need to define a new material, then use Fig. 21 as a guide:

Fig. 19 - On the Plotter tab, confirm the Machine Limits, the Origin, 
and the End Point.

Fig. 20 - On the Port tab, specify the Port Location for 
which the machine is connected. For CNC routers, there is 
often a requirement to save the cut data to a file.

Fig. 21 - Using the Materials Library dialog to define a new type of material.
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D) Set the Blank Size
The Blank Size is the visual representation of  the area that is available for cutting. For example, it could represent either a single door plate, or 
a sheet of  material wherein multiple door plates have been nested.

Note: In order to see the material size, verify that View menu >> Show Sign Blank is ON.

1.	 Choose Layout menu >> Blank Size.
2.	 Set the Orientation to either Portrait or Landscape. The customary orientation is Landscape.
3.	 Set the Origin Selection to position the workspace rulers. It is customary to start the rulers counting from the lower-left corner.
4.	 The Current Selection drop-list is used to choose the size (width by height) of  the material size. If  Custom is chosen, then the Width 

and Height fields may be entered.
5.	 Click OK to close the Blank Size dialog.

E) Define a Cutting Tool
Choose Cut menu >> Tools Library and confirm that the necessary tools are defined. These tools will be selectable later when defining the 
cut templates that are used to create tool paths. If  you need to define a new tool, then use Fig. 22 as a guide:

F) Define a Cut Template
Cut templates contain all the parameters that are used to create tool paths. By defining a cut template, it can be used repeatedly to apply those 
specific tool path parameters to objects.

Note: The following procedure assumes that the material and cutting tool have been defined. For more information, please refer to the previous 
sections: Define a Material Type, and Define a Cutting Tool.

1.	 Create a cut template as follows:
2.	 Choose Cut menu >> Cut Template Wizard.
3.	 Click Next to proceed past the introductory wizard page.
4.	 Choose the type of  tool path to create (Fig. 23) and then click Next.
5.	 Click Next to proceed to the “Use New or Existing Cut Template” page and use Fig. 24 as a guide.
6.	 Click Next to continue with the remaining wizard pages. The pages will vary according to the type of  cut template and any additional 

parameters that you choose.
7.	 On the final page of  the wizard, type a Cut Template Name and then click the Add New button.
8.	 Click Close to finish the wizard.

Fig. 22 -  Use the Tools Library dialog to define new tool bits.
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G) Define a Drill Hole Cut Template 
In the previous section, the Cut Template Wizard does not include an option for defining cut templates for drill holes. Instead, use the 
following procedure:

1.	 From the Tool Path Tools flyout, right-click the Drill tool (Fig. 25).

Fig. 23 - Cut templates are the “master” definition of all the 
parameters involved when creating a tool path.

Fig. 24 - When a cut template is applied to a shape, a tool path object 
will be created that inherits all the parameters from that template.

Fig. 25 - The Drill tool in only available from the Tool Path Tools flyout. 
To define a cut template for drill points, right-click the Drill tool.
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2.	 The Cut Template dialog will open to the Template tab (Fig. 26).
3.	 On the Template tab, set the fields accordingly.
4.	 Click the Basic Cut tab to set the feeds and speeds (Fig. 27).
5.	 Click the Add button to finished creating the new cut template.

To close the dialog, either click OK to apply, or Cancel to close without applying. If  OK is clicked, then the cursor will appear as a set of  
crosshairs for placing drill points, and each left-click will place a drill point.

For the cut template that was just created, it can be reused wherever drill points are applied, such as with the following Tool Path flyout tools: 
Drill, Drill Matrix, Drill Contour, Drill Center and Drill Corner.

H) Apply a Tool Path to an Object
The previous sections described how to create a cut template. The following steps show how to use the cut template to apply a tool path to 
an object.

1.	 Select a shape on the workspace.
2.	 From the Cut menu >> Apply Tool Path flyout, choose the type of  cut template.
3.	 The Apply Cut Template dialog will open (Fig. 28).
4.	 The top-right corner of  the dialog will indicate, “All templates displayed.”
5.	 Select the desired cut template and click OK.

Note: When applying Drill Matrix, Drill Contour, or Drill Corner tool paths, an additional dialog is used for placement of  the drill holes. Please 
refer to the Help File for an explanation of  the dialog settings.

Fig. 26 - Like the Cut Template Wizard, the Cut Template 
dialog is an alternative method of defining the parameters 
used to create a tool path.

Fig. 27 - For the Drill tool, the Cut Template dialog has 
only two tabs. The number of tabs vary according to the 
type of cut template.
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I) Previewing and Cutting the Tool Path
1.	 Now that the tool path has been created, choose Cut menu >> Plot to activate Cut Preview mode.

Alternatively, click the Cut Tool to activate Cut Preview.

2.	 The tool path will be previewed as it will be cut upon the material, and a green bounding rectangle used to represent the machine limits 
(Fig. 29).

3.	 In the SmartBar, verify that both the Tool and Device are the same as were selected previously within the Plot dialog.
4.	 At this point, the cut data is ready to be sent from SignLab. Please confirm that the machine is online and loaded with the appropriate 

material.
5.	 On the Cut Toolbox, click the Cut button to begin sending cut data.

Note: If  the Port Location of  the Plotter Setup dialog had been set to “FILE:”, then SignLab will prompt for a filename and file location 
before saving the cut data.

Fig. 28 - The Apply Cut Template dialog displays the choices for 
given type of cut template. Clicking OK will create a tool path object.

Fig. 29 - In Cut Preview mode, click the Cut button to begin output.
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Print&Cut

Print and/or Cut to Roland VersaWorks
Note: When you launch SignLab for the first time, a Browse for Folder dialog will ask you to identify the VersaWorks installation directory. 
Once this has been done, SignLab will be configured to use the color profiles that are set within your VersaWorks, thereby providing you with 
the necessary color matching for your media and inks.

For the SignLab for VersaWorks™ Edition, when a print and/or cut job is sent from SignLab to VersaWorks, a special cut path name is used 
to tag cut paths within the job file. By default, the cut path name is set as “CutContour” when SignLab is installed. However, if  you have 
changed the default cut path name within VersaWorks, then you will need to tell SignLab to use the correct cut path name when outputting to 
VersaWorks.

If  you wish to complete a print-only job, then skip the steps in gray.

1.	 In SignLab, choose Options menu >> SignLab Setup >> PostScript Setup.
2.	 The PostScript dialog will open (Fig. 30).
3.	 By default, “CutContour” is the name that VersaWorks uses to recognize cut paths in jobs that are received from SignLab.

4.	 On the SignLab workspace, import or create your design.
5.	 Choose File menu >> Print to Roland VersaWorks.
6.	 When prompted, choose whether the job should go to Queue A or Queue B.

The job will now be received by VersaWorks.

Fig. 30 - When printing a job, a PostScript file is sent to the RIP 
software. For third-party RIP software, the variables used to describe 
the job can vary between software developers.
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Print&Cut

Print and/or Cut to Mimaki RasterLink
Note: When you launch SignLab for the first time, a Browse for Folder dialog will ask you to identify the RasterLink installation directory. 
Once this has been done, SignLab will be configured to use the color profiles that are set within your RasterLink, thereby providing you with the 
necessary color matching for your media and inks.

For the SignLab for Mimaki™ Edition, when a print and/or cut job is sent from SignLab to RasterLink, a special cut path name is used to 
tag cut paths within the job file. By default, the cut path name is set as “MPC_CD_0” when SignLab is installed. However, if  you have 
changed the default cut path name within RasterLink, then you will need to tell SignLab to use the correct cut path name when outputting to 
RasterLink.

If  you wish to complete a print-only job, then skip the steps in gray.

1.	 In SignLab, choose Options menu >> SignLab Setup >> PostScript Setup.
2.	 The PostScript dialog will open (Fig. 31).
3.	 By default, “MPC_CD_0” is the name that RasterLink uses to recognize cut paths in jobs that are received from SignLab.

4.	 On the SignLab workspace, import or create your design.
5.	 Choose File menu >> Print to RasterLink. The RasterLink dialog will open to the Preferences tab (Fig. 32).

Fig. 31 - When printing a job, a PostScript file is sent 
to the RIP software. For third-party RIP software, the 
variables used to describe the job can vary between 
software developers.

Fig. 32 - The RasterLink dialog provides additional operations 
that can be performed before the job is sent from SignLab.
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6.	 On the Preferences tab, near the bottom are “Selected objects” and “Edge of  sign blank” checkboxes for specifying whether objects 
need to be selected, or within the sign blank bounds to be included with the job.

7.	 Also note that controls are available for generating copies of  the job, though bear in mind that registration marks will be generated for 
each of  these copies, which will introduce additional seek time for locating registration marks.
It is recommended that the Layout menu >> Array feature be used instead of  creating copies. After creating the array, sending the job 
will produce registration marks for the overall job, rather than for individual copies.

Alternatively, the Layout menu >> Badges feature can be used to prepare copies with automatic text substitution and serialization.

8.	 If  you are sending a print-only job, then please skip to step (15).
9.	 On the Cutting Options tab (Fig. 33), the registration marks can be set.

Note: The Cutting Options tab will not be available if  cut paths have not been created on the workspace.

10.	 The Registration marks section is used to indicate the type and characteristics of  the registration marks that will be create.
These registration mark settings must correspond to what is set from the cutter control panel, otherwise the cutter will not be able to 
recognize the registration marks.

11.	 In the Cut conditions section, the Contour cuts drop-list is used for choosing from one of  five presets that are defined at the cutter 
control panel.

12.	 Likewise, the Half  cuts drop-list is used to choose the preset when performing Half  Cut operations.
13.	 Each of  the presets is configured for cutting at a given speed, pressure, etc.

The Specify button can be used to create a new set of  configurations, which will be transmitted and become available at the cutter 
control panel.

14.	 Please note that if  (say) you change the size of  the registration marks, then you need to update the given preset (that you’ve chosen) at 
the cutter control panel. Otherwise, there will be a mismatch that prevents the machine from accurately locating the registration marks.

15.	 Once the RasterLink dialog settings are complete, click OK to continue and the job will be sent to the RasterLink window.
16.	 The Rasterlink window provides a simple flat list of  the pending jobs, along with a thumbnail of  the givens jobs.
17.	 To send a given job, right-click to access its context menu, and then choose from the Cut flyout.

Fig. 33 - If there are no cut paths on the SignLab workspace, then 
the Cutting options tab is hidden.
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Sending Jobs to Visual Production Manager (VPM)
There are a variety of  means that jobs can be sent directly to Visual Production Manager, as opposed to importing or linking the design into 
SignLab first.

For the PhotoShop, Illustrator and CorelDraw workflows,  a special Send to VPM plug-in that is used instead of  File menu >> Print. For 
garment printing, there is also a Send to VPM with Underbase plug-in that will automatically create a white ink underbase for the design.

□□ Sending Jobs from PhotoShop - In PhotoShop, the Send to VPM plug-ins are available through the File menu >> Automate flyout.
□□ Sending Jobs from Illustrator - In Illustrator, the Send to VPM plug-ins are available under the File menu. 
□□ Sending Jobs from CorelDraw - In CorelDraw, the Send to VPM plug-ins are available as buttons on the Standard toolbar.

□□ Sending Jobs from Other Design Applications - Where the Send to VPM plug-ins are not available, this workflow describes how to 
configure File menu >> Print to send jobs from your third-party graphic design application to VPM.

□□ Importing Designs Directly into VPM - If  a saved design file is available, it can be imported directly into VPM.

□□ Sending Jobs Across a Network - This workflow uses Windows remote printer sharing to send jobs from one Windows system to 
another Windows system.

□□ Sending Jobs from Non-Windows Computers - This workflow uses a specially designated Hot Folder for VPM to receive jobs from 
non-Windows systems.

□□ Sending Jobs from Mac OSX to VPM - This workflow uses Windows remote printer sharing in combination with Samba (SMB) 
networking protocol, such that Mac OSX applications can File menu >> Print directly to VPM.

For workflows that involve preparing and sending jobs from within SignLab, see Sending Jobs from SignLab
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Print&Cut

Print&Cut

Print&Cut

Sending Jobs from PhotoShop®
In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button.

In PhotoShop
2.	 Prepare the print design in PhotoShop.
3.	 For black garment material, use Filter menu >> CADlink >> KnockMeBlackOut to reduce the amount of  black ink that will be 

printed. Likewise for color garment material, use KnockMeColorOut to reduce ink that matches the garment color.

4.	 Create a path that will represent the cutting path (See Creating Paths in PhotoShop).

5.	 Save the PSD file, such that the design is not “untitled.”
6.	 Choose File menu >> Automate >> Send to VPM.
7.	 In the Send to VPM dialog, choose the queue name and click OK.
8.	 The job will be received in VPM.
	 Alternatively, the PSD file (or an exported file in TIFF or JPEG format) will preserve the path information, which can then be loaded 

into VPM via File menu >> Import File.

In VPM

9.	 The PhotoShop Document Path Import Options dialog will open.
10.	 Tick the Import working path as cut lines checkbox.
11.	 In the Cut Line Color section, choose the color that will identify the path within the imported file (i.e., the imported path will be 

converted into a “cut path” and assigned this color).

Note: For the path color, choose an unique color that will specifically represent paths to be cut from VPM. All vectors that have this stroke 
color will be processed as cut paths.

12.	 Click OK to proceed with the import options.

13.	 (Optional) If  the Image Import dialog is enabled, then clicking OK will proceed with the import.

14.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data is present.
15.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

16.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.

Creating Paths in PhotoShop
The following are quick pointers for creating paths in PhotoShop:

□□ To view paths within a PhotoShop file, inspect the Paths palette (Window menu >> Paths)
□□ To draw paths from the Paths palette, click the Create new path button, and then use the Pen Tool (P). The Path Selection Tool (A) 

is used to select and move path nodes.
□□ If  shape tools (U) are being used, then click the Paths button. When shapes are drawn, paths will be created instead of  filled pixels.
□□ If  the selection marquee would make a good path, then from the Paths palette click the Make work path from selection button.
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Print&Cut

Print&Cut

Print&Cut

Sending Jobs from Illustrator®
In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 

2.	 Choose Queue menu >> Properties >> Color Actions tab.
3.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
4.	 Click OK to close the Queue Properties dialog.

In Illustrator
5.	 Prepare the print design in Illustrator.

6.	 Create a shape that will represent the cutting path.
7.	 For the cut path shape, assign an invisible fill, and create a hairline stroke that uses the color set in step (3).

8.	 Save the design file, such that the design is not “untitled.”
9.	 Choose File menu >> Send to VPM.

If  the design is being prepared for printing to a black or color garment material, then choose Send to VPM with Underbase.

10.	 In the Send to VPM dialog, choose the queue name and click OK.
11.	 The job will be received in VPM.

In VPM

12.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
13.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

14.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Print&Cut

Print&Cut

Print&Cut

Sending Jobs from CorelDraw®
In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 

2.	 Choose Queue menu >> Properties >> Color Actions tab.
3.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
4.	 Click OK to close the Queue Properties dialog.

In CorelDraw
5.	 Prepare the print design in CorelDraw.

6.	 Create a shape that will represent the cutting path.
7.	 For the cut path shape, assign its fill to None, and assign a hairline stroke that uses the color set in step (3).

8.	 Save the design file, such that the design is not “untitled.”
9.	 From the Standard toolbar, click the Send to VPM button (Fig. 34).

If  the design is being prepared for printing to a black or color garment material, then click Send to VPM with Underbase.

10.	 In the Send to VPM dialog, choose the queue name and click OK.
11.	 The job will be received in VPM.

In VPM

12.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
13.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

14.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.

Fig. 34 - The Send to VPM buttons in CorelDraw.
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Print&Cut

Print&Cut

Print&Cut

Sending Jobs from Other Design Applications
For other design applications that were not covered in the previous sections, the File menu >> Print command can be used to send jobs 
to Visual Production Manager (VPM). However, please note that the design application must be capable of  defining vectors, which will be 
converted into cut paths when received by VPM.

In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 
2.	 Choose Queue menu >> Manage Queues.
3.	 In the Control Panel column, click the Install button, such that the queue is available as a print destination for other Windows 

applications.
4.	 Click the Close button.

5.	 Choose Queue menu >> Properties >> Color Actions tab.
6.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
7.	 Click OK to close the Queue Properties dialog.

In Your Design Application
Once your queue has been installed in the Windows Control Panel, it can be selected as a print destination within your graphic design 
application.

8.	 In your design application, prepare the print design.

9.	 Create a shape that will represent the cutting path.
10.	 For the cut path shape, assign an invisible fill, and create a hairline stroke that uses the color set in step (6).

11.	 Choose File menu >> Print.
12.	 From the Printer drop-list, choose the queue that had been designated in step (3).
13.	 The description for the printer (if  any) should indicate that it is a “Visual Production Manager” or “CADlink” destination.

Note: It is possible for printer names to be quite similar to the queue name you have selected. If  description does not indicate “Visual 
Production Manager” or “CADlink,” then check for a similar name from the Printer drop-list.

Set the Media Profile
Media profiles in VPM are referred to as “print modes,” which contain all of  the printer settings (resolution, printer options, ink levels, etc.) 
that are used with a given job. Use the following procedure to set the print mode from within your graphic design application.

14.	 From the Print dialog of  your graphic design application, there should be a Page Setup or Properties button that will open the 
Document Properties dialog (Fig. 35).

15.	 Click the Advanced button. The Advanced Options for the driver will open (Fig. 36).
16.	 Under Document Options, locate the Printer Features category and click the Print Mode field.
17.	 The Print Mode drop-list will become active.
18.	 Choose the print mode that is most appropriate for the media and image quality. Print modes are typically named according to media, 

print resolution, ink density, halftone frequency, and ink set.
19.	 Click OK to close the Advanced Options.
20.	 Click OK again to close the Properties dialog.
21.	 Click OK to close the Print dialog, and the job will be received in VPM.

In VPM

22.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
23.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

24.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Fig. 35 - The Document Properties dialog provides access to 
the printer driver settings by clicking the Advanced button.

Fig. 36 - In the printer driver settings, choose the 
Print Mode that will be used. Sending a File menu >> 
Print job in this fashion will override the print mode 
set within the Queue Properties dialog.
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Importing Designs Directly into VPM
Design files can be imported directly into Visual Production Manager (VPM), without the need to open the files in their original design 
applications. Use this workflow where you have a design file that must be printed without having access to the original design application. For 
example, the customer has sent you a design file, and you need to print the file “as is” without importing it into a design application.

Note: The supported image formats are subject to change, though common image formats are supported (e.g., EPS, AI, PDF, BMP, JPEG, 
TIFF, etc.).

In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 

2.	 Choose Queue menu >> Properties >> Color Actions tab.
3.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
4.	 Click OK to close the Queue Properties dialog.

In the Design Application
5.	 Prepare the print design.

6.	 Create a shape that will represent the cutting path.
7.	 For the cut path shape, assign its fill to None, and assign a hairline stroke that uses the color set in step (3).

8.	 Save the design file.
For print&cut designs, the file must be saved in a format that supports stroke information (i.e., EPS, AI, PDF, etc.).

In VPM
9.	 Load the design file using one of  the following three methods:

a)	 Choose File menu >> Import File.
b)	 From the toolbar, click the Open button.
c)	 Drag-and-drop the file into the VPM window.

10.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
11.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

12.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Sending Jobs Across a Network
Use this workflow when your design application is on a separate computer from where Visual Production Manager (VPM) is installed. Once 
this configuration is complete, the File menu >> Print command will be used to send jobs across the network to VPM.

Note: This workflow uses Windows remote printer sharing. If  the design application is installed on a non-Windows computer, then please use 
the next workflow, “Sending Jobs from Non-Windows Computers.”

Note: For Windows remote printer sharing, the computers must be either BOTH 32-bit Windows, or BOTH 64-bit Windows. Otherwise, a 
mismatch between 32-bit and 64-bit will cause a Windows driver incompatibility that prevents jobs from proceeding.

In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 
2.	 Choose Queue menu >> Manage Queues.
3.	 In the Control Panel column, click the Install button, such that the queue is available as a print destination for other Windows 

applications.
4.	 Click the Close button.

5.	 Choose Queue menu >> Properties >> Color Actions tab.
6.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
7.	 Click OK to close the Queue Properties dialog.

Enable Windows Remote Printer Sharing
(On the computer that has VPM)

8.	 From the Start menu, open the Windows Printers and Faxes (This is also available through the Control Panel).
9.	 In the list of  printers, the queue name will be listed as one of  the available printers.

The Comments column will indicate that this is a “CADlink Printer,” and the Model column should indicate the printer model.

10.	 Right-click the queue name, and choose Sharing from the drop-list.
11.	 The Properties dialog will open, and the Sharing tab will be active.
12.	 Click the Share this printer option.
13.	 For the Share name, type a meaningful name. This name will appear to design computers when they are connecting to the VPM 

computer.
By default, Windows will initially truncate the share name to eight (8) characters, which is a precaution against incompatible filename 
lengths with older Windows versions.

14.	 Click OK to close the Properties dialog.

Connect to the Shared Printer
(On the computer with the design application)

15.	 From the Start menu, choose My Network Places and browse the network to the (remote) computer that has VPM.
16.	 In the top directory of  the remote computer, the shared printer should be listed as a “CADlink Printer.”
17.	 Right-click the shared printer and choose Connect from the drop-list.
18.	 The printer will now be available through the File >> Print command of  your design application.

Note: In the Windows Control Panel, a VPM printer can be identified by opening its Properties dialog and inspecting the Ports tab.
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In the Design Application
19.	 In the design application, prepare the print design.

20.	 Create a shape that will represent the cutting path.
21.	 For the cut path shape, assign an invisible fill, and create a hairline stroke that uses the color set in step (6).

22.	 Choose File menu >> Print.
23.	 From the Printer drop-list, choose the queue that had been designated in step (3).
24.	 The description for the printer (if  any) should indicate that it is a “Visual Production Manager” or “CADlink” destination.

Note: It is possible for printer names to be quite similar to the queue name you have selected. If  description does not indicate “Visual 
Production Manager” or “CADlink,” then check for a similar name from the Printer drop-list.

In VPM

25.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
26.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

27.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Sending Jobs from Non-Windows Computers
This workflow uses a specially designated Hot Folder (i.e., a directory on the hard drive). When design files are printed as a file to the Hot 
Folder, they will be automatically detected by Visual Production Manager (VPM) and processed.

Once configuration is complete, the File menu >> Print command (or equivalent) will be used to send jobs to VPM. This configuration 
allows for design applications on non-Windows computers to print directly to VPM.

In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

Create an Empty Hot Folder
1.	 Create an empty directory on your VPM computer, or elsewhere on your network. This will be your Hot Folder, which must satisfy the 

following two conditions:
a)	 The VPM computer must have login permission to read and write to the Hot Folder. 
b)	 Your graphic designers must have file access permissions to write/copy files into the Hot Folder.

In VPM
2.	 From the toolbar, click the Start Queue button.

3.	 Choose Queue menu >> Manage Queues.
4.	 In the Control Panel column, click the Install button, such that the queue is available as a print destination for other Windows 

applications.
5.	 Click the Close button.

6.	 Choose Queue menu >> Properties.
7.	 Click the Hot Folders tab.
8.	 Tick the Enable Queue Hot Folder checkbox, which opens a browse dialog.
9.	 Browse to the Hot Folder that had been designated in step (1). Please note that the Hot Folder must be empty when it is initially 

chosen.
10.	 Click OK to accept the Hot Folder path.

11.	 Click the Color Actions tab.
12.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.

13.	 Click OK to close the Queue Properties dialog.

In the Design Application
14.	 In the design application, prepare the print design.

15.	 Create a shape that will represent the cutting path.
16.	 For the cut path shape, assign an invisible fill, and create a hairline stroke that uses the color set in step (12).

17.	 Choose File menu >> Print (or the equivalent according to the software being used).
If  it is permitted by the design software, then the design file can be “printed” to a data file that is placed directly into the Hot Folder. In 
this manner, printing will be seamless because VPM will automatically process the file.

Alternatively, save the design file in a commonly accepted format (e.g., EPS, AI, PDF, BMP, JPEG, TIFF, etc.), and copy the design file 
into the Hot Folder. However, for print&cut designs, the file must be saved in a format that supports stroke information (i.e., EPS, AI, 
PDF, etc.).

In VPM

18.	 In the Active List, the job thumbnail will have a knife icon to indicate that cut data has been located.
19.	 To see the cut paths in the Visual Print Manager, choose Show Print and Cut Previews from the drop-list.

20.	 If  your queue is set to hold received jobs, then select the job and choose to either print, cut or print&cut from the Jobs menu.
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Sending Jobs from Mac OSX to VPM
Use this workflow to print directly from Mac OSX applications to a shared Visual Production Manager (VPM) printer under Windows. Once 
configuration is complete, the File menu >> Print command will be used to send jobs across the network to VPM.

Note: This workflow uses Windows remote printer sharing in combination with Samba (SMB) networking protocol. For an alternative workflow 
that uses Hot Folders, please refer to the Sending Jobs from Non-Windows Computers section.

Note: For Windows remote printer sharing, the computers must be either BOTH 32-bit Windows, or BOTH 64-bit Windows. Otherwise, a 
mismatch between 32-bit and 64-bit will cause a Windows driver incompatibility that prevents jobs from proceeding.

In the following procedure, the gray boxes represent steps that are necessary in order to include cut paths with your print job (i.e., to create a 
print&cut job). If  you wish to complete a print-only job, then skip the steps in gray.

In VPM
1.	 From the toolbar, click the Start Queue button. 
2.	 Choose Queue menu >> Manage Queues.
3.	 In the Control Panel column, click the Install button, such that the queue is available as a print destination for other Windows 

applications.
4.	 Click the Close button.

5.	 Choose Queue menu >> Properties >> Color Actions tab.
6.	 Click Add Color to define a specific vector color (CMYK or named) that VPM will recognize as a cut path.
7.	 Click OK to close the Queue Properties dialog.

Enable Windows Remote Printer Sharing
(On the Windows computer that has VPM)

8.	 From the Start menu, open the Windows Printers and Faxes (This is also available through the Control Panel).
9.	 In the list of  printers, the queue name will be listed as one of  the available printers.

The Comments column will indicate that this is a “CADlink Printer,” and the Model column should indicate the printer model.

10.	 Right-click the queue name, and choose Printer Properties >> Sharing tab.
	 (For older Windows versions, choose Sharing from the context menu.)

11.	 On the Sharing tab, click the Share this printer option.
12.	 For the Share name, type a meaningful name that has no spaces between words. This name will appear to design computers when they 

are connecting to the VPM computer.
Do not create a name that has spaces between words because this will cause an authentication error when attempting to send print jobs 
via Samba networking protocol.

Older Windows may initially truncate the share name to eight (8) characters, which is a precaution against incompatible filename lengths 
with older Windows versions.

13.	 Click OK to close the Properties dialog.

Make Note of the Computer Name and Domain
(Again, on the Windows computer that has VPM)

1.	 Go Start menu >> Control Panel >> System and Security.
2.	 Within the System section, click “See the name of  this computer”
3.	 Make note of  the Computer Name, which is the unique name that identifies this computer on the network. We will refer to this name 

later as computer_name.
4.	 Make note of  the Domain, which is the unique name that has been assigned to the network that the computers belong to. We will refer 

to this later as domain_name.
Note that the Full computer name is often listed in the form:

computer_name.domain_name
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Add the Shared Printer to Mac OSX
(On the Mac OSX computer that has the design application)

1.	 Go to System Preferences.
2.	 Click Print & Fax.
3.	 Click the ‘+’ button to open the Add Printer dialog.
4.	 Right-click within the toolbar and choose Customize Toolbar.
5.	 From the selection of  icons, drag the Advanced icon into the toolbar.
6.	 Click the Done button.
7.	 Click the Advanced button (i.e., the icon that you just added to the toolbar).
8.	 From the Type drop-list, choose Windows.
9.	 In the URL field, type the SMB path for the shared printer, which should be in the following form:

smb://user_name:password@domain_name/computer_name/printer_name

Note: After the printer has been shared, the user name and password will be hidden when inspecting the SMB path.

10.	 For the Name field, type a meaningful name that users will recognize as the shared printer (i.e., this name will be the selected printer in 
Print dialogs).

11.	 From the Print Using drop-list, choose Generic PostScript Printer.
12. Click the Add button.
13. An Installable Options page will list hardware options. Click Continue.
14.	 The Print & Fax dialog will now list the shared printer. 

In the Design Application
19.	 In the design application, prepare the print design.

20.	 Create a shape that will represent the cutting path.
21.	 For the cut path shape, assign an invisible fill, and create a hairline stroke that uses the color set in step (6).

22.	 Choose File menu >> Print.
23.	 From the Printer drop-list, choose the shared printer (i.e., which will send jobs to VPM).

Editing the SMB path in Mac OSX
If  the user name, password, or other part of  the SMB path need to be updated, then either you can repeat the procedure for adding a shared 
printer to Mac OSX, or you can use the following procedure to edit the SMB path:

1.	 Launch the Safari web browser.

2.	 In the address bar, type the following address:  localhost:631
3.	 Browse and select the (VPM) printer that was shared from the Windows computer.
4.	 Choose Modify Printer from the drop-list.
5.	 The Current Connect field should indicate an smb path in the following form. Note that the previously entered user_name and 

password are hidden.

smb://domain_name/computer_name/printer_name

6.	 Click the Windows Printer via SAMBA option.
7.	 Click the Continue button.
8.	 Edit the smb path as desired, and include the user login and password, as follows:

smb://user_name:password@ domain_name/computer_name/printer_name

9.	 Click the Continue button.
10.	 Click the Continue button again.
11.	 Click the Modify Printer button.
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Connect to a Shared Windows Directory
The following procedure will authenticate a Mac OSX computer to access shared directories on a Windows system, such as a Hot Folder for 
sending jobs to VPM.

From the Windows Computer
1.	 Right-click the directory and choose Properties.
2.	 From the Sharing tab, choose to share the folder.
3.	 Click OK to accept the Property dialog settings.

From the Mac OSX Computer
1.	 Click the background workspace of  the Mac OSX desktop, such that the Finder is active.

At the top-left of  the desktop, to the left of  the File menu, there will be a Finder menu.

2.	 Choose Go menu >> Connect to server.
4.	 The Connect to Server dialog will open.
5.	 In the Server Address field, type the SMB path in the following form:

smb://domain_name/computer_name/printer_name

6.	 Click the ‘+’ button to add the address to the list of  Favorite Servers.
8.	 Click the Connect button.
9.	 Mac OSX will query for login information (tick the checkbox to add this login information to the keychain).
10.	 A Finder window will now display the contents of  the shared folder, and the Mac OSX system has access permissions to the shared 

directory.


